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1 Introduction

Thank you for choosing this device produced by the Swedish encoder manufacturer Leine & Linde. In your 
hands, you have a state of art component that is ready to be used in the outmost demanding environment. 
This absolute encoder equipped with PROFINET interface, enables you to design high performance automation 
systems. 

This manual describes the installation procedures and confi guration of absolute encoder and encoder gate-
ways with PROFINET interface. If you are in need of assistance during the system design phase, commissioning 
or during operation, please make sure that you contact your local Leine & Linde representative.

1.1 Applicability of manual

This product manual is applicable to Leine & Linde CRG PROFINET gateways and Leine & Linde absolute encod-
ers within the following encoder series.

 RSA 607 ISA 607  ISA 637  ISA 647
 RSA 608 ISA 608  ISA 638  ISA 648
 RHA 607 IHA 607  IHA 637  IHA 647
 RHA 608 IHA 608  IHA 638  IHA 648

Leine & Linde is a company that often customizes the product to fi t individual requirements of our customers. 
Such customized products may therefore not be fully compliant with the descriptions in this product manual. 
Customized encoder devices are indicated by their type label, and marked 69X where the “9” digit in the second 
position indicates that the device has some customized parameters. Encoder series with the following name 
and type plate information may therefore have deviating functional performance.

 RSA 697 ISA 697 
 RSA 698 ISA 698
 RHA 697 IHA 697
 RHA 698 IHA 698
 
If your product is of the type mentioned above, contact Leine & Linde to obtain the product’s complete 
functional description.

1.2 About Leine & Linde 

For more than 40 years, the Swedish based company Leine & Linde has concentrated on one thing – development 
and manufacturing of advanced encoders that meet the most rigorous demands a user can place on them. 
That is why a wide assortment of incremental and absolute encoders with obvious concentration on robust 
products and quality down to the last detail can be offered. Leine & Lindes encoders provide the utmost in 
reliability year after year, in working conditions where vibration, dirt, cold and other harsh environments are 
common. 

Leine & Linde can meet very specifi c individual demands. Due to a modular design in the collection, the encoders 
are easily adapted exactly to the customer’s needs with respect to resolution, electrical connections and inter-
faces, voltage, casings, etc. That is due to the fact that tomorrow’s technology is already being used today in 
Leine & Linde products. Leine & Linde concentrates on advanced development of intelligent encoders with inte-
grated ASICs, new special features and with adaptations to different fi eld bus systems. This enables us to meet 
the need for increasingly effective and dependable machines and automation to an even higher degree.
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1.3 About absolute encoders

With an absolute encoder, each angular position is assigned a coded position 
value. This is generated by a code disc equipped with several parallel fi ne 
graduations tracks which are scanned individually. On single turn encod-
ers, i.e. an encoder producing absolute positions within one revolution, the 
absolute position information repeats itself with every revolution. So called 
multiturn encoders can also distinguish between revolutions. The numbers 
of unique revolutions is determined by the resolution of the multiturn scan-
ning and repeats itself once the total resolution is reached. A benefi t of the 
absolute encoder type is that if the encoder loses power, the encoder is also 
able to keep track of its position if the shaft is turned during the power loss. 
This is due to the genuine absolute scanning principle. 

An absolute encoder can also be used to calculate a digital speed value. By internally dividing the difference in 
position by a small delta time, an accurate speed value can be calculated and transmitted to the subsequent 
electronics for closed loop control. 

1.4 About encoder gateway
The advantages of the gateway concept is that it allows the use of  small 
and very robust EnDat encoders, which make the encoder gateway solution 
suitable in applications where very high ambient temperature is a limit-
ing factor. Another benefi t with the gateway solution is that in case of an 
encoder error occurs, the EnDat encoder can easily be replaced without the 
need to disconnect the PROFINET bus. The encoder gateway works with all 
Leine & Linde EnDat encoders. The encoder gateway supports singleturn en-
coders with up to 31 bit resolution and multiturn encoders with up to 37 bits 
resolution with the limitations described in this manual.

1.5 About PROFINET technology

PROFINET is the open industrial Ethernet standard of PROFIBUS & PROFINET International (PI) for automation. 
PROFINET uses TCP/IP and IT standards, and is in effect, real-time Ethernet. The PROFINET concept features a 
modular structure so that users can select the cascading functions themselves. They differ essentially because 
of the type of data exchange in order to fulfi ll the very high speed requirements.

In conjunction with PROFINET, the two perspectives PROFINET CBA and PROFINET IO exist. PROFINET CBA is 
suitable for the component-based communication via TCP/IP and the real-time communication for real-time 
requirements in modular systems engineering. Both communication options can be used in parallel.

PROFINET IO was developed for real-time (RT) and isochronous real-time (IRT) communication with the 
decentralized periphery. The designations RT and IRT merely describe the real-time properties for the 
communication within PROFINET IO.

To achieve these functions, three different protocol levels are defi ned:
• TCP/IP for PROFINET CBA and the commissioning of a plant with reaction times in the range of 100ms 
• RT (Real-Time) protocol for PROFINET CBA and PROFINET IO applications up to 1 ms cycle times 
• IRT (Isochronous Real-Time) for PROFINET IO applications in drive systems with cycle times of less   
 than 1ms 
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Interfacing the peripherals devices such as encoders is performed through PROFINET IO. Its basis is a cascading 
real-time concept. PROFINET IO defi nes the entire data exchange between controllers (devices with “master 
functionality”) and the devices (devices with “slave functionality”), as well as parameter setting and diagnosis. 

PROFINET IO is designed for the fast exchange of data between Ethernet-based fi eld devices and follows the 
provider-consumer model. The confi guration of an IO-System has been kept nearly identical to the “look and 
feel” of PROFIBUS. 

A PROFINET IO system consists of the following devices:
• The IO Controller, which controls the automation task. 
• The IO Device, which is a fi eld device such as an encoder, 
 monitored and controlled by an IO Controller. 
• The IO Supervisor is software typically based on a PC for setting parameters 
 and diagnosing individual  IO Devices. 

An application relation (AR) is established between an IO Controller and an IO Device. These ARs are used 
to defi ne communication relations (CR) with different characteristics for the transfer of parameters, cyclic 
exchange of data and handling of alarms.
The characteristics of an IO Device are described by the device manufacturer in a General Station Description 
(GSD) fi le. The language used for this purpose is the GSDML (GSD Markup Language) – an XML based language. 
The GSD fi le provides the supervision software with a basis for planning the confi guration of a PROFINET IO 
system.

Within PROFINET IO, process data and alarms are always transmitted in real-time (RT). Real-time in PROFINET 
is based on the defi nition of IEEE and IEC, which allows for only a limited time for execution of real-time services 
within a bus cycle. The RT communication represents the basis for the data exchange for PROFINET IO and 
real-time data are always treated with a higher priority than TCP (UDP)/IP data. 

1.6 Encoder Profi les

Profi les are pre-defi ned confi gurations of the functions and features available from PROFINET for use in specifi c 
devices or applications such as encoders. They are specifi ed by PI (PROFIBUS & PROFINET International) working 
groups and are published by PI. Profi les are important for openness, interoperability and interchangeability, so 
that the end user can be sure that similar equipment from different vendors perform in a standardized way. 
Leine & Linde complies with the defi nitions in the encoder profi le 3.162, version 4.1. The encoder device profi le 
describing encoder functionality and additional information about PROFINET can be ordered from PROFIBUS 
User Organization, PNO or directly from Leine & Linde AB.

PROFINET is generally defi ned by PROFIBUS & PROFINET International (PI) and is backed by the INTERBUS 
Club. Since 2003, it has been part of the IEC 61158 and IEC 61784 standards.

PROFIBUS User Organization

Haid-und-Neu Straße 7
DE-76131 Karlsruhe, Germany

Tel: +49-(0)721-96 58 590
Fax: +49-(0)721-96 58 589
Web: www.profi bus.com
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2 Declaration of conformities

This device conforms to prevailing legal requirements and is designed in accordance with proper engineering 
practices. A certifi cate of conformity can be provided upon request from Leine & Linde. 
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3 Technical and commercial support

Leine & Linde is represented by subsidiaries in many countries around the world. In addition to the address 
listed here, there are many services agencies and distributors located worldwide ready to reply to commercial 
enquires or technical support. For more information, please visit our website or contact Leine & Linde in 
Strängnäs, Sweden.

Leine & Linde AB

Box 8  
SE-645 21 Strängnäs, Sweden

Tel: +46-(0)152-265 00
Fax: +46-(0)152-265 05
E-mail: info@leinelinde.com
Web: www.leinelinde.com

3.1 References

Profi le Encoders for PROFIBUS and PROFINET V4.1, Order No 3.162 
Profi le Drive Technology, PROFIdrive V4.1, Profi bus International, Order Nr: 3.172

PROFIBUS Encoder Profi le V1.1, Profi bus International, Order Nr: 3.062
PROFIBUS Guidelines, Part 1: Identifi cation & Maintenance Functions V1.1, Profi bus International, Order Nr: 3.502
PROFIBUS Guidelines, Part 3: Diagnosis, Alarms and Time Stamping V1.0, Profi bus International, Order No. 3.522

PROFINET – Application Layer Service Defi nition – Application Layer Protocol Specifi cation, Version 2.0, 
Profi bus International, Order No. 2.332

PROFIBUS Guidelines: PROFIBUS Interconnection Technology V1.1, Profi bus International, Order No. 2.142

PROFINET Guidelines: PROFINET Cabling and Interconnection Technology V1.99, Profi bus International, 
Order No. 2.252

3.2 Abbreviations

PI  PROFIBUS and PROFINET International
IO  Input/Output
DO   Drive Object
DU  Drive Unit
AR  Application Relation
CR   Communication Relation
MLS   Master Sign-Of-Life
RT   Realtime Ethernet
IRT   Isochronous Realtime Ethernet
IsoM  Isochronous Mode
LLDP Link Layer Discovery Protocol
GSD  General Station Description
GSDML General Station Description Markup Language
UDP  User Datagram Protocol
TCP  Transmission Control Protocol
IP  Internet Protocol
TFTP Trivial File Transfer Protocol
MAC  Media Access Control
I&M  Identifi cation & Maintenance
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4 Installation

A summary of the PROFINET guideline: PROFINET Cabling and interconnection Technology V 1.99, 
Profi bus International, Order No 2.252 is provided in this section.

4.1 Cables and standards

Two shielded copper cables twisted in pairs are defi ned as the normal transmission medium for PROFINET 
networks. In such networks, the signal transmission is performed in accordance with 100BASE-TX at a trans-
mission speed of 100 Mbps (Fast-Ethernet).

Only shielded cables and connecting elements are allowed in a PROFINET network. The individual components 
have to satisfy the requirements of Category 5 in accordance with IEC 11801. The entire transmission path has 
to meet the requirements of Class D in accordance with IEC 11801. Furthermore, PROFINET cables must have 
a cable cross-section of AWG 22 in order to enable even complex cabling structures through minimum damping. 
For this reason, the specifi cation of the PROFINET cables supports a modular setup, which ensures an IEC 
11801-compliant structure in adherence to simple installation rules. 

Transmission channel lengths are determined by the type of cable being used. The choice of cable shall be such 
that a transmission channel length of 100 meters is achieved between two active network devices. The use of a 
high number of plug connections has a negative effect on attenuation and refl ection and consequently reduces 
the transmission channel length. A maximum of three interconnections can be inserted between two active 
devices without reduction of the permissible transmission lengths of 100 meters.

4.2 Connectors and pin confi guration for absolute encoder

A major criterion for use in industry is the handling of local connection systems. 
Connectors for M12 are available for this purpose.

M12 connectors are used for PROFINET data communication of the encoder, constituted by a 
4-pin female shielded D-coded version.

The correct arrangement of the bus connectors is specifi ed as follows:

Note: The encoder provides integrated switch functionality between the two M12 connectors used for PROFI-
NET communication. It is important to distinguish between these ports when IRT-communication is being 
used. 

Port 1

Port 2

Signal Function Pin

Tx+ Transmission data + 1

Tx- Transmission data - 3

Rx+ Receiver data + 2

Rx- Receiver data - 4
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The M12 connectors used for power supply of the encoder is constituted by a 4-pin male shielded 
A-coded version.

The correct arrangement of the power supply line is specifi ed as follows:

Note: It is not possible to use passive T-couplings in a PROFINET network. 
All devices must be connected through active network components.

4.3 Connectors and pin confi guration for CRG PROFINET gateway

The PROFINET data communication is constituted by 4p M12 female D-coded connector and the power supply 
is constituted by a 4pM12 A –coded male connector. The EnDat encoder interface is constituted by either a 17p 
female CCW connector or an 8pM12 A-coded female connector depending on the model.

Supply

Signal Function Pin

+E Volt Power supply 1

Not connected - 2

0 Volt 0 Volt 3

Not connected - 4

PROFINET and supply connection:

Connector 
type

4p M12 
D-coded 
female

4p M12 
D-coded 
female

4p M12 A-
coded male

Function Port 1 Port 2 Supply

TX+ 1 1 -

RX + 2 2 -

TX - 3 3 -

RX - 4 4 -

+E Volt power 
source A

- - 1

+E Volt power 
source B *)

- - 2

0 Volt - - 3

0 Volt - - 4

*) For a secondary power supply.
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Note: The encoder gateway provides integrated switch functionality between the two M12 connectors used 
for PROFINET communication. It is important to distinguish between these ports when IRT-communication 
is being used.

Note: It is not possible to use passive T-coupling in a PROFINET network. All devices must be connected 
through active network components.

4.4 Shielding concept of the device

Automation systems in an industrial environment are subjected to high levels of electromagnetic disturbance. 
Switching large electrical loads creates high interference levels that can be picked up in various ways by electronic 
devices with detrimental effects. Even under such conditions, electrical components within an automation 
system must still guarantee a continuous, uninterrupted function. 

The electromagnetic compatibility (EMC) of the entire plant must be ensured by using suitably designed com-
ponents and assembling them correctly to create the system. Data cabling is considered a passive system and 
cannot be tested for EMC compliance individually. Nevertheless, cabling and connection elements for PROFINET 
support compliance with device requirements by providing a high-quality, comprehensive shielding concept. 

To achieve the highest possible noise immunity and resistance against other EMC related disturbances, the bus 
and power supply cables must always be shielded. The screen should be connected to ground on both ends of 
the cable. In certain cases, compensation current might fl ow over the screen.  

EnDat encoder connection:

Connector type 17p M23
CCW female

8p M12 A-coded 
female

Function Encoder input 
(17p M23)

Encoder input  
(8pM12)

0V sense 4 1

+E Volt sense 1 2

Data 14 3

Data inverted 17 4

0 Volt 10 5

Clock inverted 9 6

Clock 8 7

+E Volt 7 8
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4.5 MAC-address

To make the device unique, it is given an ID, i.e. the 
MAC address, which is a string loaded in the device. 
The MAC address is constituted by a 6-byte Ethernet 
address for each individual station and is unique 
worldwide. A MAC-ID consists of two parts, the fi rst 3 
bytes represents the manufacturer-specifi c ID and the 
last 3 bytes represents a consecutive number. For the 
encoder and the encoder gateway, the MAC address is 
always printed on the encoder label for commission-
ing purposes. See picture.

4.6 LED indication

The following table defi nes diagnostic indications shown by the encoders two bi-colored LEDs. Encoder models 
ISA/IHA 647/648 are not equipped with LEDS. Therefore the LED indication table below is not applicable for 
these models.

Bus Module Meaning Cause

Off Off No Power

Red Green No connection to another de-
vice. Criteria: No data exchange.

-  Bus disconnected
-  Master not available / switched off

Blinking* 
red

Green Parameterization fault, no 
data exchange. Criteria: Data 
exchange correct, however the 
encoder did not switch to the 
data exchange mode.

-  Slave not confi gured yet or wrong 
   confi guration
-  Wrong station address assigned
-  Actual confi guration of the slave 
   differs from the nominal confi gura-           
   tion

Green Red System failure - Diagnosis exists, slave in data ex-
   change mode

Green Green Data exchange and encoder 
functions properly

Blinking* 
green

Blinking* 
green

Firmware upgrade in process

Blinking* 
red

Blinking* 
red

Failure during fi rmware 
upgrade

*) The blinking frequency is 0.5 Hz. Minimal indication time is 3 seconds.
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5 Confi guration example

This chapter will illustrate how to setup and confi gure a PROFINET encoder for working in RT Class 1 mode 
with SIMATIC MANAGER. The encoder gateway is confi gured in a similar way as the encoder example shown in 
this chapter. In the following examples, Siemens STEP 7 V5.4 +SP5 PLC and CPU 315F-2PN/DP are used. Please 
refer to the manufacturer if other confi guration tools are being used.

5.1 Device description fi le installation (GSDML)

In order to start using an absolute encoder or encoder gateway with PROFINET interface, a device description 
fi le needs to be downloaded and imported to the confi guration software. The device description fi le is called a 
“Generic Station Description Markup Language” fi le and contains the necessary implementation parameters 
needed for a PROFINET IO device.

The latest available GSDML fi le can be downloaded from www.leinelinde.com

Available GSDML fi le for 
absolute encoder

Note

GSDML-V2.2-LL-PROFINET-
ENCODER-xxxxxxxx.xml

This GSDML fi le requires:
SIMATIC STEP 7 V5.4 +SP5 or later or 
SIMOTION SCOUT V4.1.5.6 or later.

This GSDML fi le is just supported by encoders with software Revision 
V3.2.0, which are delivered in encoders with serial number 30125167 or 
higher and have been delivered after 01-01-2011. Older encoders with 
lower serial numbers need a fi rmware upgrade to support this GSDML 
fi le.

GSDML-V2.2-LL-RxA600-
xxxxxx.xml

This GSDML fi le is only supported for compatibility reasons 
and should not be used by new users.

Available GSDML fi le for 
encoder gateway

Note

CRG PROFINET GSDML-V2.2-
LL-PROFINET-GATEWAY-
xxxxxxxx.xml

This GSDML fi le requires:
SIMATIC STEP 7 V5.4 +SP5 or later or 
SIMOTION SCOUT V4.1.5.6 or later.
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Installation of GSDML-fi les in SIMATIC MANAGER:

1) Select Options-> Install GSD File and click the “Browse” button to navigate to the location of the GSD   
 fi le. If a bitmap picture representing the encoder is requested, make sure that the bitmap fi le is located   
 in the same folder as the GSDML fi le. A bitmap fi le is included in the zip-fi le downloadable from 
 www.leinelinde.com.

2) Select the GSD fi le and click the “Install” button to start installing the selected GSD fi le. 

5.2 Setting the encoder confi guration

Once the GSD fi le has been installed, the encoder type can be found in the SIMATIC MANAGER-> HW Confi g 
under PROFINET IO-> Additional Field Devices-> Encoders-> LEINE LINDE PROFINET Encoders. Select either 
multiturn 25 bit or singleturn 13 bit encoder, depending on the type of encoder to be confi gured. Drag and drop 
the encoder onto the PROFINET IO system as shown in the picture below. In the example below, one 25 bit 
multiturn encoder was chosen. If more than one encoder is connected and is to be confi gured, then the following 
steps need to be performed once for each connected device.
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When correctly done, the encoder will appear on the PROFINET IO system as shown in the picture below.

The next step is to choose the data length and the type of data that is to be sent to and from the controller. 
This is done by choosing different telegrams. Available telegrams for the multiturn 25 bit encoder can be found 
under Multiturn 25 Bit-> EO Multiturn. In the example below, standard telegram 81 which contains 32 bits posi-
tion values is used. Drag and drop the telegram onto slot 1, sub-slot 2 as shown in the picture below. For more 
information regarding the different telegrams refer to chapter 6.4.

The “Standard Telegram 81” will appear on slot 1 sub slot 2

Please note that the steps described above need to be performed for each connected device.
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5.3 Set encoder device name

In a PROFINET network, all IO devices need to have a unique device name. Leine & Linde’s PROFINET encoders 
are delivered without any device name preset from the factory. To set the encoder device name, double-click on 
the encoder icon to open the Properties window.

In the Properties dialog window, enter an appropriate device name in the “Device name” fi eld. 

Make sure that the checkbox “Assign IP address via IO controller” is checked, if the IP-address for the encoder 
should be assigned via the IO controller.

Then select PLC-> Ethernet-> Assign Device Name to open the “Assign device name window”.



PROFINET
USER MANUAL    www.leinelinde.com

19

Choose the device on which the device name should be changed and then click the “Assign name” button 
to adopt the changes. Then click the “Close” button.

 

Please note that all connected devices need to be assigned a device name.
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After changing device name, it is recommended to verify the performed changes.
This is done by opening the “Verify Device Name” window found under PLC-> Ethernet-> Verify Device Name.

In the “Verify Device Name” dialog window, verify that the “Device name” has changed and the status is 
confi rmed OK as shown in the picture below. 
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5.4 Setting encoder parameters

This chapter describes how to change the user parameters in the encoder. The way to open the Properties win-
dow depends on which version of GSDML-fi le is used. To set the parameter data while using a GSDML-fi le with 
a release date earlier than 01-01-2010, double click on the fi eld beneath slot 0 according to the picture below to 
open the Properties window. The release date of the GSDML-fi le forms part of the fi lename of the fi le. For exam-
ple: “GSDML-V2.2-LL-RxA600-20090512.xml” was released the 12th May 2009.

To set the encoder user parameters using a GSDML-fi le with a release date after 01-01-2010, 
double click on the “Parameter Access point” slot 1.1 as shown below to open the Properties window.
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In the Properties window, choose the “Parameters” tab.
To set the parameter data, change the value of the different parameters by clicking on the drop-down list in the 
“Value” fi eld for the respective parameter. Please note that the parameter “Class 4 Functionality” must be enabled 
in order to change some of the available parameters. For more information regarding this, see chapter 9.

Once the confi guration and parameterization of the device has been completed, the settings need to be saved 
and compiled. This is done by clicking on the “Save and Compile” option under the “Station” tab
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The settings then need to be downloaded to the IO-controller.
This is done by clicking on the “Download” option under the “PLC” Tab.
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5.5 Isochronous Real-Time Settings (RT Class 3)

This example is intended to illustrate the commissioning of a PROFINET encoder in isochronous operation. 
In the example below, a STEP 7 v5.4 SP5 and SIMOTION D435 motion controller is used. The basic principal 
for confi guration and parameterization of the encoder is the same as described in chapter 5.2 & 5.3.

To set the IRT settings of a Leine & Linde encoder, double-click on the “Interface” fi eld located under slot 0, 
sub slot X1 to open the Properties window and follow the instructions below.
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Under the “Synchronization” tab, change the value for the Parameter “RT Class” to IRT and the “IRT option” 
parameter to “High Performance” according to the picture below.

Under the “Application tab”, check the box for “Operate IO device/application in isochronous mode”.
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Under the “IO Cycle” tab, change the Update Time Mode to “fi xed factor”.

Before the encoder can operate in IRT mode, it is necessary to set from which port of the encoder the 
connection to the network has been made. 

To set the topology, double-click on the port from which the encoder is connected to the network. 
This is either slot 0 sub-slot P1 or slot 0 sub-slot P2. In the example below, Port 1 is used on the encoder. 
For port description of the encoder, refer to chapter 4, Mechanical installation.
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Under the “Topology” tab, change the “Partner port:” to the port used by your IO controller.
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Once the above steps have been performed, it is recommended that you verify the setting for the encoder 
and the IO controller is correct. This is done by opening the “Domain management” Window found under 
Edit-> PROFINET IO.

Verify that the RT Class is set to IRT and that the IRT option is set to High performance.

The encoder is now prepared for operating in IRT mode.

 



PROFINET
USER MANUAL    www.leinelinde.com

29

6 PROFINET IO data description

6.1 Encoder Profi le overview, PNO order no. 3.162

This manual relates to encoders that fulfi ll the demands and functionality according to encoder profi le V4.1 
(PNO no 3.162). The operating functions for encoders according to this profi le are divided into two application 
classes, named Class 3 and Class 4. For an overview of the different encoder profi le for PROFIBUS and 
PROFINET and the related standards, see the picture below.

For further information regarding the encoder functionality, refer to the device profi le. The profi le and 
PROFINET technical information can be ordered at PNO in Karlsruhe, Germany (www.profi net.com).

6.2 Application Class defi nition

Leine & Linde’s PROFINET encoders can be confi gured as a class 3 or class 4 PROFINET IO-device according 
to the encoder profi le V.4.1 (PNO no 3.162). A Class 4 confi gured encoder from Leine & Linde fully supports all 
functionality according to the encoder profi le V4.1 

CLASS 3 Encoder with base-mode parameter access and limited parameterization of the encoder 
 functionality. Isochronous mode is not supported. 
 
CLASS 4 Encoder with scaling, Preset and base-mode parameter access. Isochronous mode is supported.



PROFINET
USER MANUAL  www.leinelinde.com

30

6.3 Standard signals

The table below describes the standard signals that are used to confi gure the IO data. 
The signals are described in the chapters that follow.

Signifi cance Abbreviation Length (bits) Data type

Velocity value A NIST_A 16 Signed

Velocity value B NIST_B 32 Signed

Control word G1_STW 16 Unsigned

Status word G1_ZSW 16 Unsigned

Position value 1 G1_XIST1 32 Unsigned

Position value 2 G1_XIST2 32 Unsigned

Position value 3 G1_XIST3 64 Unsigned

Control word 2 STW2_ENC 16 Unsigned

Status word 2 ZSW2_ENC 16 Unsigned

6.4 Standard telegrams

Confi guration of PROFINET encoders are made by choosing different telegram structures. The telegrams are 
used to specify the data length and which type of data that are sent to and from the IO-controller. A confi guration 
error will occur if for example a 37 bits multiturn encoder is used and have been confi gured with telegram 
81-83. A 37 bit encoder need telegram 84 which supports 64 bit position values.

Leine & Linde’s PROFINET encoders and encoder gateways supports the standard and manufacturer specifi c 
telegrams according to the table below.

Telegram Encoder gateway Absolute encoder

Standard telegram 81 Supported Supported

Standard telegram 82 Supported Supported

Standard telegram 83 Supported Supported

Standard telegram 84 Supported Supported

Manufacturer telegram 59000 Supported Not supported

Manufacturer telegram 59001 Supported Supported

STANDARD TELEGRAM 81 
Standard telegram 81 uses 4 bytes for output data from the IO-controller to the encoder and 12 bytes 
of input data from the encoder to the IO-controller. 

Output data from the IO-controller:
Control word 2 = STW2_ENC
Control word =  G1_STW
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IO Data (word) 1 2

Byte 0 1 2 3

Set point STW2_ENC G1_STW

Output data from IO-Controller

Input data to the IO-Controller:
Status word 2= ZSW2_ENC
Status word= G1_ZSW
Position value 1= G1_XIST1
Position value 2= G1_XIST2

IO Data (word) 1 2 3 4 5 6

Byte 0 1 2 3 4 5 6 7 8 9 10 11

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2

Input data to IO-controller

STANDARD TELEGRAM 82 
Standard telegram 82 uses 4 bytes for output data from the controller to the encoder and 14 bytes of input data 
from the encoder to the controller.

Output data from the IO-controller:
Control word 2= STW2_ENC
Control word = G1_STW

IO Data (word) 1 2

Byte 0 1 2 3

Set point STW2_ENC G1_STW

Output data from IO-controller

Input data to the IO-controller:
Status word 2= ZSW2_ENC
Status word = G1_ZSW
Position value 1 = G1_XIST1
Position value 2 = G1_XIST2

IO Data (word) 1 2 3 4 5 6 7

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13

Set point ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_A

Input data to IO-controller

STANDARD TELEGRAM 83 
Standard telegram 83 uses 4 bytes for output data from the controller to the encoder and 16 bytes of input data 
from the encoder to the controller.
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Output data from the IO-controller:
Control word 2 = STW2_ENC 
Control word = G1_STW

IO Data (word 1 2

Byte 0 1 2 3

Set point STW2_ENC G1_STW

Output data from IO-controller

Input data to the IO-controller:
Status word 2 = ZSW2_ENC
Status word = G1_ZSW
Position value 1 = G1_XIST1
Position value 2 = G1_XIST2
Velocity value B = NIST_B

IO Data (word 1 2 3 4 5 6 7 8

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_B

Input data to IO-controller

STANDARD TELEGRAM 84 
Standard telegram 84 uses 4 bytes for output data from the controller to the encoder and 20 bytes of input data 
from the encoder to the controller.

Output data from the IO-controller:
Control word 2 = STW2_ENC 
Control word = G1_STW

IO Data (word) 1 2

Byte 0 1 2 3

Set point STW2_ENC G1_STW

Output data from IO-controller

Input data to the IO-controller:
Status word 2 = ZSW2_ENC
Status word = G1_ZSW
Position value 3 = G1_XIST3
Position value 2 = G1_XIST2
Velocity value B = NIST_B

IO Data (word) 1 2 3 4 5 6 7 8 9 10

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

Actual value  ZSW2_ENC G1_ZSW G1_XIST3 G1_XIST2 NIST_B

Input data to IO-controller
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Note: In standard telegram 84, G1_XIST2 is used to transfer error codes and optionally position values 
if the measuring length exceeds 64 bits.

6.5 Manufacturer telegram 59000

Manufacturer telegram 59000 is only supported by the encoder gateway. Telegram 59000 is similar to standard 
telegram 83 but with an added 32 bit acceleration value. Telegram 59000 uses 4 bytes for output data and 20 
bytes of input data.

Output data to the IO-controller:
STW2_ENC= Control word 2 (16 bit)
G1_STW= Control word (16 bit)

Byte 0 1 2 3

Set point Control word 2 (STW2_ENC) Control word (G1_STW)

Output data from IO-controller to encoder

The manufacturer telegram 59000 input data consist of a position values, velocity value and acceleration ac-
cording to below. The velocity value uses the format that is defi ned in the parameter Velocity measuring unit 
and is presented in hundredths of rpm. Two velocity data types can be used, unsigned 32 bit with direction 
shown in the MSB (set when negative direction) or signed 32 bit. 

The acceleration value is presented in tenths of rpm/s. It means that the NIST_B value will be presented as 
1000 rpm if the actual shaft speed is only 10 rpm and that the ACC_B value will be presented as 10 rpm/s if the 
actual acceleration is 1 rpm/s.

The velocity is calculated according to the formula (1):

∂x      Xnew-Xold

∂t       Tintegration
V =        =           (1)

Where

V  is the velocity value;
dX/dt   is the fi rst time derivative of the position X;
Xnew   is the new position value;
Xold   is the old position value;
Tintegration is the integration time in ms;

The acceleration is calculated according to the formula (2):

                       (2)

Where

a  is the acceleration value;
dV/dt   is the fi rst time derivative of the velocity V;
Vnew   is the new velocity value;
Vold   is the old velocity value;
Tintegration is the integration time in ms;

∂v      Vnew-Vold

∂t       Tintegration
a =        =
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Input data to the IO-controller:
ZSW2_ENC= Status word 2 (16 bit unsigned)
G1_ZSW= Status word (16 bit unsigned)
G1_XIST1=Position value 1 (32 bit unsigned)
G1_XIST2=Position value 2 (32 bit unsigned)
NIST_B=Velocity value B (32 bit signed)
ACC_B= Acceleration value B (32 bit unsigned)

IO Data (word) 1 2 3 4 5 6 7 8 9 10

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_B ACC_B

Input data from encoder to IO-controller

Note: User parameter Class 4 functionality and G1_XIST1 Preset control must be activated in order to 
activate the preset in manufacturer telegram 59000. 

Note: Data type for the acceleration value is the same as the selected data type for velocity.

6.6 Manufacturer telegram 59001

This manufacturer specifi c telegram is supported by the encoder and the encoder gateway.
The manufacturer telegram 59001 is a simplifi ed telegram to get cyclic data transmission and also the possibil-
ity to do a preset via IO-data without the need of control word and status words.

The preset function can be used to set the actual position of the encoder to any entered value within the work-
ing range of the encoder. If scaling is active and has been done on the encoder it is only possible to enter a 
preset value within the scaled working range of the encoder. 

The preset is activated when the Most Signifi cant Bit (bit 31) is set to 1.  The actual preset value should be en-
tered in the other following bits according to below.

Byte 0 1 2 3

Bits 31 (MSB) 30-24 23-16 15-8 7-0 (LSB)

Preset control bit Preset value < total resolution

Output data from IO-controller to encoder

The manufacturer telegram 59001 input data consist of a 4 byte position value and a 4 byte velocity value as 
shown below. The velocity value uses the format that is defi ned in the Velocity measuring unit.

IO Data (word) 1 2 3 4

Byte 0 (MSB) 1 2 3 (LSB) 4 (MSB) 5 6 7 (LSB)

Actual value Position value 32 Bit Unsigned int Velocity value 32 Bit Signed int

Input data from encoder to IO-controller

Note: User parameter Class 4 functionality and G1_XIST1 Preset control must be activated in order to acti-
vate the preset in manufacturer telegram 59001.
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6.7 Format of G1_XIST1 and G1_XIST2

The G1_XIST1 and G1_XIST2 signals consist of the absolute position value in binary format. By default, the 
G1_XIST1 signal is equal to the G1_XIST2 signal.  The format of the actual position values in G1_XIST1 and 
G1_XIST2 is shown below.

Format defi nition for G1_XIST1 and G1_XIST2:
• All values are presented in binary format.
• The shift factor is always zero (right aligned value) for both G1_XIST1 and G1_XIST2.
• The setting in the encoder parameter data affects the position value in both G1_XIST1 and G1_XIST2.
• G1_XIST2 displays the error telegram instead of the position value if error occurs.

Example: 25-bit multiturn absolute encoder (8,192 steps per revolution, 4,096 distinguishable revolutions).

M = Multiturn value (Distinguishable revolutions) 
S = Singleturn value (number of steps per revolution)

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

M M M M M M M M M M M M S S S S S S S S S S S S S

MSB Absolute value in G1_XIST1 LSB

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

M M M M M M M M M M M M S S S S S S S S S S S S S

MSB Absolute value in G1_XIST2 LSB

6.8 Format of G1_XIST3

G1_XIST3 is a 64-bit position value that is used to support encoders with a resolution exceeding 32 bits.

Format defi nition for G1_XIST3:
• Binary format.
• The actual position value is always right aligned; a shifting factor is not used.
• The settings in the encoder parameter data affect the position value in G1_XIST3 if Class 4 is enabled.

IO Data (word) 1 2 3 4

Format 64 bit position value

6.9 Control word 2 (STW2_ENC)

The control word 2 (STW2_ENC) is referred to as the “master sign-of-life” and it includes the fault buffer 
handling and Control by PLC mechanism from PROFIdrive STW1 and the Controller Sign-Of-Life mechanism 
from PROFIdrive STW2. 
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Bit Function

0…6 Reserved

7   Fault Acknowledge

8, 9 Reserved

10 Control by PLC

11 Reserved

12…15 Controller Sign-Of-Life

STW2_ENC defi nition and implementation requirements

Bit Value Signifi cance Comments

7 1 Fault Acknowledge (0->1) The fault signal is acknowledged with a positive edge. 
The encoder reaction to a fault depends on the type of 
fault.

0 No signifi cance

10 1 Control by PLC Control via interface, EO IO Data is valid. 

0 No Control by PLC EO IO Data not valid, except Sign-Of-Life.

12..15 Controller Sign-Of Life

Detailed assignment of the encoder control word 2 (STW2_ENC)

6.10 Status word 2 (ZSW2_ENC)

The status word 2 (ZSW2_ENC) is referred to as the “slave’s sign-of-life” and it includes the fault buffer 
handling and Control by PLC mechanism from PROFIdrive ZSW1 and the Slave Sign-Of-Life mechanism 
from PROFIdrive ZSW2. 

Bit Function

0…2 Reserved

3   Fault Present / No Fault

4…8 Reserved

9 Control requested

10, 11 Reserved

12…15 Encoder Sign-Of-Life

ZSW2_ENC defi nition and implementation requirements
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Bit Value Signifi cance Comments

3 1 Fault Present Unacknowledged faults or currently not acknowledged 
faults (fault messages) are present (in the buffer).The 
fault reaction is fault-specifi c and device-specifi c. The 
acknowledgement of a fault may only be successful if 
the fault cause has disappeared or has been removed 
before. If the fault has been removed, the encoder 
returns to operation. The related fault numbers are in 
the fault buffer..

0 No Fault

9 1 Control requested The automation system is requested to assume 
control.

0 No Control requested Control by automation system is not possible; only 
possible at the device or through another interface.

12..15 Encoder Sign-Of-Life

Detailed assignment of the encoder status word 2 (ZSW2_ENC)

6.11 Control word (G1_STW)

The control word controls the functionality of major encoder functions.

Bit Function

0…7 Function requests: Reference mark search, measurement on the fl y

8…10   Reserved (without effect)

11 Home position mode

12 Request set/shift of home position (Preset)

13 Request absolute value cyclically

14 Activate parking sensor

15 Acknowledging a sensor error

G1_STW implementation requirements

Note: If the sensor parking is activated (bit 14 = 1), the encoder remains on the bus with the slave sign–of-
life activated and the encoder error and diagnostics switched off.
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6.12 Status word (G1_ZSW)

The status word defi nes encoder states, acknowledgements, error messages of major encoder functions.

Bit Function

0…7 Function status: Reference mark search, measurement on the fl y

8 Probe 1 defl ected

9 Probe 2 defl ected

10 Reserved, set to zero

11 Requirement of error acknowledgement detected

12 Set /shift of home position executed

13 Transmit absolute value cyclically

14 Parking sensor active

15 Sensor error

G1_ZSW implementation requirements

Note: If bit 13 “Transmit absolute value cyclically” or bit 15 “Sensor error” is not set, there is no valid 
value or error code transferred in G1_XIST2.

Note: Bit 13 “Transmit absolute value cyclically” cannot be set at the same time as bit 15 “Sensor error” 
as these bits are used to indicate either a valid position value transmission (bit 13) or the error code 
transmission (bit 15) in G1_XIST2.

6.13 Real-Time Communication

PROFINET IO uses three different communication channels to exchange data with programmable controllers 
and other devices. The non real-time channel, based on for example TCP (UDP)/IP, is used for parameterization, 
confi guration and acyclic read/write operations. 

The RT or Real-Time channel is used for process data transfer and alarms. Real-time data are treated with 
a higher priority than data sent over the open channel. RT communications overrides the open channel to 
handle the data exchange with programmable Controllers. 

The third channel, Isochronous Real-Time (IRT) is the high performance, high-speed channel used for demanding 
motion Control applications. IRT data are treated with a higher priority than RT data sent over the RT channel.
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PROFINET distinguishes between three real-time classes for transmission of time-critical process data. 
The three RT classes are:
 
REAL-TIME, RT CLASS 1

• Unsynchronized Real-time communication
• Industrial standard switches can be used
• Typical application area: Factory automation

REAL-TIME, RT CLASS 2
• Synchronized and unsynchronized data transmission
• Special switches supporting IRT is needed
• Typical application area: Factory automation

ISOCHRONOUS REAL-TIME, RT CLASS 3
The isochronous operation mode is used when real-time positioning with high-performance is required. The 
basic principal is that all PROFINET devices on the net are clock synchronized with the controller using a global 
control broadcast enabling simultaneous data accusation from all devices with microsecond accuracy. The 
data exchange cycles for IRT are usually in the range of a few hundred microseconds up to a few milliseconds. 
The difference compared to real-time communication is essentially the high degree of determinism, so that the 
start of a bus cycle is maintained with high precision. The synchronization is monitored by “sign-of life” messages 
in “Control word 2” (STW2_ENC) and “Status word 2” (ZSW2_ENC).

• Clock synchronized data transmission
• Special switches supporting IRT is needed
• IRT is required for example motion control applications
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7 Alarms and warnings

7.1 Diagnostics and Alarms

Diagnostic data is always transferred acyclically using Record Data communications over the non real-time 
channel. An IO-Supervisor must specifi cally request the diagnostic or status data from the IO-device using 
RDO (Record Data Object) services.

Alarm data is transmitted from the IO-device to the IO-controller via the RT channel. An alarm is generated 
by the encoder when a failure occurs that affects the position value. Alarms can be reset (deleted) once all 
encoder parameters are within the specifi ed value ranges and the position value is correct.

7.2 Channel diagnostics

The encoder outputs a diagnostic interrupt to the CPU when it detects one of the supported channel diagnostics.

Supported channel diagnostic Diagnostic data record Description

Position error 0x900A The encoder fails to read the correct position 
value 

Memory error 0x9000 The encoder fails to read stored offset 
or preset values from the non volatile 
memory

Commissioning diagnostics 0x9011 User parameter data assignment error

In a SIMATIC STEP 7 system, the operation system responds by calling a diagnostic OB. The OB number and 
start information provides the cause and location of the error. The error information can be read by calling a 
system Function block (SFB54 “RALRM” for STEP 7). The user can then decide how the system should handle 
the error. 

Note: If the called OB is not included in the program, the CPU will go to stop.

7.3 Sensor status word

Diagnosis information can be obtained by monitoring of the Error bit in the Sensor Status word G1_ZSW (bit 15) 
and evaluation of the error code transmitted in G1_XIST2.

Supported diagnostic Error code in G1_XIST2 Description

Sensor group error 0x0001 The encoder fails to read the correct position 
value 

Memory error 0x1001 The encoder fails to read stored offset 
or preset values from the non volatile 
memory

Command not supported 0x0F01 User parameter data assignment error 
or command error in commands words 
G1_STW and STW2_ENC

Master´s sign-of-life fault 0x0F02 The number of permissible failures the 
controller’s sign-of-life was exceeded
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8 Acyclic Parameter Data

8.1 Acyclic data exchange

In addition to the cyclic data exchange, the PROFINET encoder also supports acyclic data exchange. The acyclic 
data exchange is transferred over the non real-time channel and is used to read out and write status information 
from and to the IO-device. The acyclic data exchange is conducted in parallel to the cyclic data communication. 

Example of acyclic data:
• Reading of diagnostic
• Reading of I&M functions
• Reading of PROFIdrive parameters

8.2 Identifi cation and Maintenance (I&M functions)

Encoders according to the encoder profi le 3.162 also support I&M functionality.
The main purpose of I&M functions is to support the end user if the device is acting faulty or missing some 
of its functionality. I&M functions could be seen as an electronic nameplate containing common information 
regarding the device and its manufacturer. 

According to the PROFINET specifi cation all IO-devices must at least support the following I&M functions:
• Order ID
• MAC address
• Hardware Version
• Software Version
• Product type
• Manufacturer ID

For more information regarding additional I&M functions supported by Leine & Linde encoders, refer to 
chapter 9.14.6.

8.3 Base Mode Parameter access

The PROFIdrive parameters and the encoder parameter 65000 can be accessed by the Acyclic Data Exchange 
service using the Base Mode parameter access local (Record Data Object 0xB02E).

8.3.1 General characteristics

Acyclic parameter can be transmitted 1(single) or up to 39(multi) in one access. 
A parameter access can be up to 240 bytes long.

8.3.2 Parameter requests and responses

Request header: Request ID, DO-ID and number of parameters of the access.

Parameter address: One address for each parameter, if several parameters are accessed.

Parameter value: If the Request ID is 0x02 (change value) the value is set in the request and if the Request ID 
is 0x01 (request value), the value appears in the reply.
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8.3.4 Changing the preset value

The table below shows the structure of a change value request.

Write of Preset value, parameter 65000, Parameter request

Request reference 0x00

Request ID 0x02 0x02  Change value, 0x01 read value

DO-ID (axis) 0x01 Drive Object ID

No of parameters 0x01

Attribute 0x10 0x10 Value

No of elements 0x00

Parameter number 0xFDE8 Parameter 65000

Sub index 0x0000

Format 0x04 Data type integer 32

Number of values 0x01

8.3.5 Reading the preset value

The tables below show the structure of a read value request.

Read of Preset value, parameter 65000, Parameter request

Request reference 0x00 

Request ID 0x01 0x01 read value

DO-ID (axis) 0x01 Drive Object ID

No of parameters 0x01 0x01 Read one parameter

Attribute 0x10 0x10 Value

No of elements 0x00

Parameter number 0xFDE8 Parameter 65000

Sub index 0x0000

Read of Preset value, parameter 65000, Parameter response

Request reference 0x00 mirrored

Response ID 0x01 0x01 read value

DO-ID (axis) 0x01 mirrored

No of parameters 0x01

Format 0x04 0x04 = Data type unsigned 32

No of values 0x01

Values or errors 0x00, 0x00, 0x00, 
0x64

Preset value 100
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8.4 Supported parameters

8.4.1 Parameter 922, read only

922 unsigned int, presents which telegram is used. Standard Telegram 81, 82, 83 and 84 and manufacturer 
telegram 59000 and 59001 is possible.

8.4.2 Parameter 925, read/write

925 unsigned int, maximum allowed MLS (Master sign-of-life) error. Parameter 925 may be used to set a 
maximum on how many consecutive Sign-of-life failures may occur.

8.4.3 Parameter 964, read only

964 unsigned int

964[0] = Manufacturer Id. This is set during manufacturing of the encoder.
964[1] = 0 DU Drive unit type, always set to 0.
964[2] = 201 Software version
964[3] = 2009 Software year
964[4] = 2805 Software day and month
964[5] = 1 Number of drive objects (DO)

8.4.4 Parameter 965, read only

965  OctetString 2

965[0] =0x3D Encoder profi le number
965[1] = 31 or 41 Encoder profi le version, set by customer (user_parameters)

8.4.5 Parameter 971, read/write

971 unsigned int, Store the local parameter set to a non-volatile memory. Preset value is saved when writing 
value 1 and is set to 0 by the encoder fi rmware when fi nished. This means that the preset value has been saved 
when reading back value 0. 

8.4.6 Parameter 974, read only

974 unsigned int

974[0] = 96 Max array length supported by parameter channel.
974[1] = 1 Numbers of multi parameters, 1 = no support of multi parameters.
974[2] = 1000 max time to process parameter request, n x 10 ms.
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8.4.7 Parameter 975, read only

975 unsigned int

975[0] = Manufacturer Id, Set in the production.
975[1] = 7011 DO type
975[2] = 201 Software version
975[3] = 2009 Software year
975[4] = 2805 Software day and month
975[5] = 0x0005 Profi drive DO type class 5 = encoder interface
975[6] = 0x8000 Profi drive SUB class 1, Encoder application class 4 supported. 
975[7] = 0x0001 Drive object Id (DO ID).

8.4.8 Parameter 979, read only

979 unsigned long

979[0] = 0x00005111 Number of index describing encoders, Numbers of described encoders, 
Version of parameter structure
979[1] = 0x80000000 Sensor type
 Bit 31 = 1 if confi guration and parameterization is OK
       Bit 0 = 0 Rotary encoder, Bit 0 = 1 linear encoder 
 Bit 1 = 0 always set to 0
 Bit 2 = 0  32 bit data, Bit 2 = 1  64 bit data

979[2] = 8192 Encoder scaled resolution
979[3] = 0 Shift factor for G1_XIST1. Always set to 0.
979[4] = 0 Shift factor for G1_XIST2. Always set to 0.
979[5] = 1 or 4096 Singleturn = 1, Multiturn = 4096
979[6] = 0
979[7] = 0
979[8] = 0
979[9] = 0
979[10] = 0

8.4.9 Parameter 980, read only

This parameter shows the supported parameters
980 unsigned int

980[0] = 922 980[8] = 61000  980[16] = 65003
980[1] = 925 980[9] = 61001 980[17] = 0
980[2] = 964 980[10] = 61002
980[3] = 965 980[11] = 61003
980[4] = 971 980[12] = 61004
980[5] = 974 980[13] = 65000
980[6] = 975 980[14] = 65001
980[7] = 979 980[15] = 65002

8.4.10 Parameter 61000, read/write

Name of station
61000 OctetString, 240 octets
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8.4.11 Parameter 61001, read only

IP of station
61001 unsigned long

8.4.12 Parameter 61002, read only

MAC of station
61002 OctetString, 6 octets

8.4.13 Parameter 61003, read only

Default gateway of station
61003 unsigned long

8.4.14 Parameter 61004, read only

Subnet mask of station
61004 unsigned long

8.4.15 Parameter 65000, read/write

Used with standard telegram 81-83 and manufacturer telegram 59000
65000 signed long, preset value 32 bit.

8.4.16 Parameter 65001, read only

Used with standard telegram 81-84 and manufacturer telegram 59000
65001 unsigned long

65001[0] = 0x000C0101 Header, Version of parameter structure and numbers of index describing 
the encoder. 12 index and version 1.01
65001[1] = Operating status (Bit 4 alarm channel control is always set with profi le version 4.x)
65001[2] = Alarm
65001[3] = Supported alarms
65001[4] = Warning
65001[5] = Warnings supported
65001[6] = 0x00000401  Encoder profi le version. Always set to this value.
65001[7] = Operating time
65001[8] = Offset value
65001[9] = Singleturn value, scaled value
65001[10] = Total measuring length, scaled value (Linear = 1)
65001[11] = Velocity unit

8.4.17 Parameter 65002, read/write

Used with telegram 84
65002 signed long long, Preset value 64 bit.
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8.4.18 Parameter 65003, read only

Used with telegram 84
65003 unsigned long long, 

65003[0] = 0x0000000000040101 Header Version of parameter structure and numbers of index describing 
encoder. 4 index and version 1.01
65003[1] = Offset value 64 bit
65003[2] = Singleturn value 64 bit, scaled value
65003[3] = total measuring range in measuring units 64 bit, scaled value (Linear =1)

8.5 Example of reading and writing to a parameter

This is an example of S7 blocks used for reading and writing to parameter 65000 (preset value). 
Experience with S7 programming and Statement List programming language STL is required.

Hardware components

IO-Controller Siemens S7-F CPU CPU 315F-2

IO-Device Leine & Linde PROFINET encoder

Software components

Siemens S7-F CPU V5.4 +SP5

GSDML fi le for PROFINET encoder GSDML V2.2-LL-Profi net-encoder-20100225

8.5.1 Used blocs

Write record block SFB53 “WRREC”
Read record block SFB52 “RDREC”
Instance data blocks DB3 and DB4
Request data block DB1
Response data block DB2
Organization blocks OB1, OB82 and OB86

SFB52
SFB52 is standard S7 block for reading parameters.

SFB53
SFB53 is standard S7 block for writing parameters.

DB1
DB1 is the request data block.
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DB2
DB2 is the response data block.

DB3
DB3 is the instance data block of SFB52.

 

DB4
DB4 is the instance data block of SFB53.
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OB1
OB1 controls the read-and-write operation.



PROFINET
USER MANUAL    www.leinelinde.com

49



PROFINET
USER MANUAL  www.leinelinde.com

50

Parameters of SFB52

Parameter Declaration Data type Description

REQ INPUT BOOL REQ = 1 Enables data transfer

ID INPUT DWORD Logical address of the PROFINET IO module or 
sub module (PAP-module address 2039)

INDEX* INPUT INT Record number

MLEN* INPUT INT Maximum length of the record information in 
bytes

VALID OUTPUT BOOL New record has been received and is valid.

BUSY OUTPUT BOOL Busy = 1 during the read operation

ERROR OUTPUT BOOL Error = 1 read error

STATUS OUTPUT DWORD Block status or error code

LEN* OUTPUT INT Length of record information

RECORD IN_OUT ANY Target area for the record

*) Negative values are interpreted as 16-bit unsigned integers.

Parameters of SFB53

Parameter Declaration Data type Description

REQ INPUT BOOL REQ = 1 Enables data transfer

ID INPUT DWORD Logical address of the PROFINET IO module or 
sub module (PAP-module address 2039)

INDEX* INPUT INT Record number

LEN* INPUT INT Length of the record information in bytes

DONE OUTPUT BOOL Data record was transferred

BUSY OUTPUT BOOL Busy = 1 during the write operation

ERROR OUTPUT BOOL Error = 1 write error

STATUS OUTPUT DWORD Block status or error code

RECORD IN_OUT ANY Data record

*) Negative values are interpreted as 16-bit unsigned integers.
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Diagnostic address of slot 1
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Variable table
With the variable table, the user can monitor and modify variables.

 

To change the value of Parameter 65000 with the variable table perform the following steps:

1) Enable monitoring by clicking the Monitor Variable button.

2) Write 02hex to address DB1.DBB 1 by entering B#16#02 in the modify value column.
 (01hex=parameter request, 02hex=change parameter).

3) Write the new preset value in hexadecimal to address DB1.DBD 12 by entering the value in the modify  
 value column. (Ex: DW#16#000001F4).

4) Click the button Modify variable. The status value of DB1.DBB 12 should now contain the new value.

5) Run the program – right click on M8.4 and click “Modify address to 1” to run the program. Then stop 
 the program by right click and click “Modify address to 0”.

6) The status value of DB2.DBD 6 should now have changed to the new preset value.

7) Change the value in DB1.DBB 1 to 01hex (B#16#01) and click modify variable.

8) To set the encoder to the new preset value bit 12 in control word must be set to “1”. This is done by 
 writing 1000hex (W#16#1000) to address PQW 2. Then Click the button Modify variable to make the 
 preset of the encoder.

9) The encoder can now at anytime be set to the preset value by setting bit 12 in control word.
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9 Functional description of Leine & Linde devices

This chapter describes the functions that have been implemented in PROFINET devices from Leine & Linde. The 
table below shows the supported functions in a Leine & Linde PROFINET device.

Function

Code sequence

Class 4 functionality

G1_XIST1 Preset control

Scaling function control

Alarm channel control

Compatibility mode

Preset value

Preset value 64 bit

Measuring units per revolution / Measuring step

Total measuring range

Measuring units per revolution 64 bit

Total measuring range 64 bit

Maximum Master Sign-Of-Life failures

Velocity measuring unit

Encoder Profi le version

Operating time

Offset value

Offset value 64 bit

9.1 Code sequence

The code sequence defi nes whether the absolute position value should increase during clockwise or counter 
clockwise rotation of the encoder shaft seen from fl ange side. The code sequence is set by default to increase 
the absolute position value when the shaft is turned clockwise (0).

Attribute Meaning Value

CW Increasing position values with clockwise rotation 
(viewed from shaft side)

0

CCW Increasing position values with counter clockwise 
rotation (viewed from shaft side)

1

Code sequence attributes

Note: The position value will be affected when the code sequence is changed during operation. 
It may be necessary to perform a preset after the code sequence has been changed.
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9.2 Class 4 functionality

This parameter enables or disables the functions Scaling, Preset and Code sequence. If the function is enabled, 
scaling and Code sequence control affects the position value in G1_XIST1, G1_XIST2 and G1_XIST3. A preset will, 
in this case, always affect G1_XIST2 and G1_XIST3 but if the parameter “G1_XIST1 Preset control” is disabled 
the preset will not affect the position value in G1_XIST1. 

Attribute Meaning Value

Enable Scaling/preset/code sequence control enabled 1

Disable Scaling/preset/code sequence control disabled 0

Class 4 functionality attributes

9.3 G1_XIST1 Preset control

This parameter controls the effect of a preset on the G1_XIST1 actual value. If “Class 4 functionality” is 
activated and “G1_XIST1 Preset control” is disabled, the position value in G1_XIST1 will not be affected by 
a Preset. 

Attribute Meaning Value

Enable G1_XIST1 is affected by a Preset command 0

Disable Preset does not affect G1_XIST1 1

G1_XIST1 Preset control attributes

Note: This parameter is disabled by setting the value to 1.

Note: There is no functionality of this parameter if the “Class 4 functionality” parameter is disabled.

9.4 Scaling function control

This parameter enables or disables the Scaling function of the encoder.

Attribute Meaning Value

Enable Scaling function is enabled 1

Disable Scaling function is disabled 0

Scaling function control attributes

Note: The parameter “Class 4 functionality” must be enabled to use this parameter. 
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9.5 Alarm channel control

This parameter enables or disables the encoder specifi c Alarm channel transferred as Channel Related 
Diagnosis. This functionality is used to limit the amount of data sent in isochronous mode.

If the value is zero (default value) only the communication related alarms are sent via the alarm channel. 
If the value is one (1) also encoder profi le specifi c faults and warnings are sent via the alarm channel.

Attribute Meaning Value

Enable Profi le specifi c diagnosis is switched on 1

Disable No Profi le specifi c diagnosis (default) 0

Alarm channel control attributes

Note: This parameter is only supported in compatibility mode.

9.6 Compatibility mode

This parameter defi nes if the encoder should run in a mode compatible to Version 3.1 of the Encoder Profi le. 
See below for an overview of functions affected when the compatibility mode is enabled.

Attribute Meaning Value

Enable Compatibility with Encoder Profi le V 3.1 0

Disable No backward compatibility (default) 1

Compatibility mode attributes

Function Compatibility mode Enable (= 0) Compatibility mode Disabled (= 1)

Control by PLC 
(STW2_ENC)

Ignored, the Control word (G1_STW) 
and set point values are always valid. 
Control requested (ZSW2_ENC) is not 
supported and is set to 0.

Supported

User parameter 
“Maximum” Master 
Sign-Of-Life failures”

Supported Not supported, one Sign-Of-Life failure 
tolerated, PROFIdrive P925 is optional to 
control the life sign monitoring.

User parameter 
“Alarm channel 
control”

Supported Not supported, the application alarm 
channel is active and controlled by a 
PROFIdrive parameter.

P965 – Profi le Version 31 (V3.1) 41 (V4.1)

Compatibility mode defi nition
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9.7 Preset value

The preset value function enables adaptation of the position value from the encoder to a known mechanical 
reference point of the system. The preset function sets the actual position of the encoder to zero (= default 
value) or to the selected preset value. A preset value can be set more than once and it can be stored to the 
non-volatile memory using PROFIdrive parameter 971.

The preset function has an absolute and a relative operating mode selectable by bit 11 in the Control word 
(G1_STW). Bit 11 and bit 12 in the Control word control the preset as follows:

Normal operating mode:  Bit 12 = 0
In this mode, the encoder will make no change in the output value.

Preset mode absolute: Bit 11 = 0, Bit 12 = 1
In this mode, the encoder reads the current position value and calculates an internal offset value from the 
preset value and the current position value. The position value is then shifted with the calculated offset value 
to get a position value equal to the preset value. No preset will be made if a negative preset value is used while 
trying to initiate an absolute preset.

Preset mode relative: Bit 11 = 1, Bit 12 = 1
In this mode, the position value is shifted by the preset value, which could be a negative or a positive value 
set by encoder parameter 65000 or 65002.

The steps below should be followed by the IO-controller when modifying the Preset value parameters:
1. Read the requested Preset value parameter and check if the returned value meets the application 
 requirements. If not, proceed with the following steps.
2. Write the Preset value into the individual parameter.
3. Store the value in the non–volatile memory by PROFIdrive parameter 971 if the value should also be   
 valid after the next power-on sequence.

Parameter Meaning Data type

Preset value The preset value for encoders with a measuring range of 
maximum 32 bits

Integer 32

Preset value 64 bit The preset value for encoders with a measuring range 
exceeding 32 bits

Integer 64

Preset value parameters

Note: The preset function should only be used at encoder standstill

Note: The number of possible preset cycles is unlimited.

Note: If scaling is used, the preset function should be used after the scaling function 
to ensure that the preset value is entered in the current measuring unit.

Note: There is no preset activated when the Preset value is written to the encoder. The preset function 
is controlled by bits in the control and status words (G1_STW and G1_ZSW) and bit in the operating 
parameters. The preset value is used when a preset is requested by bit 12 in the Control word (G1_STW).



PROFINET
USER MANUAL    www.leinelinde.com

57

9.8 Scaling function parameters

The scaling function converts the encoder’s physical absolute position value by means of software in order to 
change the resolution of the encoder. The scaling parameters will only be activated if the parameter “Class 4 
functionality” and “Scaling function control” are enabled. The permissible value range for the scaling is limited by 
the resolution of the encoder. The scaling parameters are securely stored in the IO-controller and are reloaded 
into the encoder at each power-up. 

9.8.1 Measuring units per revolution

This parameter sets the singleturn resolution of the encoder. In other words, it is the number of different meas-
uring steps during one revolution of the encoder.

Example: For a 13-bit encoder with a singleturn resolution of 13 bits, the permissible value range for 
“Measuring units per revolution” is between 20 and 213 (8192). 

Parameter Meaning Data type

Measuring units per 
revolution 

The singleturn resolution in measuring steps Unsigned 32

Measuring units per 
revolution 64 bit

The singleturn resolution in measuring steps for en-
coders with a resolution exceeding 32 bits.

Unsigned 64

Singleturn scaling parameters

Note: After downloading new scaling parameters, the preset function must be used to set the encoder 
starting point to absolute position 0 or to any required starting position within the scaled operating range.

9.8.2 Total measuring range

This parameter sets the total measuring range of the encoder. The total measuring range is calculated 
by multiplying the singleturn resolution with the number of distinguishable revolutions. 

Example: The total measuring range for a 25 bit RXA 608 multiturn encoder with a 13 bit singleturn resolution 
and a 12 bit multiturn resolution, the permissible value range for the “Total measuring range” is between 20 and 
225 (33,554,432).

The total measuring range is calculated as below:
Measuring units per revolution x Total measuring range  
= 8192 (213) x 4096 (212)
= 33,554,432

If the total measuring range is higher than 31 bit, telegram 84 and acyclic encoder parameter 65002 and 65003 
must be used. In this case, the 64-bit values are used and the 32-bit values are set to zero (0) by the encoder.

The device has two different operating modes, depending on the specifi ed measuring range. When the device 
receives a parameter message, it checks the scaling parameters to identify if a binary scaling can be used. If 
binary scaling can be used, the device selects operating mode A (see following explanation). If not, operating 
mode B is selected.
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<<A. CYCLIC OPERATION (BINARY SCALING)
Cyclic operation is used when operating with 2X number of turns (2, 4, 8, 16, 32, 64, 128, 256, 512, 1,024, 2,048, 
4,096….. number of turns). If the desired total measuring range is equal to the specifi ed single turn resolution 
* 2X (where x< = 12) the encoder operates in endless cyclic operation (0 – max – 0 – max…). If the position value 
increases above the maximum value by rotating the encoder shaft, the encoder continues from 0.

Example of a cyclic scaling:
Measuring units per revolution  = 1,000
Total measuring range  = 32,000 (25 = number of revolutions 32)

Cyclic scaling

B. NON-CYCLIC OPERATION
If the desired total measuring range is not equal to the specifi ed single turn resolution * 2X (where x< = 12) the 
encoder operates in non-cyclic operation. The non-cyclic operation is affected by the parameter G1_XIST 1 
Preset control as described below.

G1_XIST 1 Preset control = Enabled
If the position value increases or decreases outside the maximum value or below 0 with the parameter 
G1_XIST 1 Preset control enabled, the device outputs the maximum position value within the scaled total 
range for both position values G1_XIST 1 and G1_XIST 2.

Example of non-cyclic scaling with G1_XIST 1 Preset control enabled:
Measuring units per revolution  = 100
Total measuring range  = 5,000 (number of revolutions 50)

Non-cyclic scaling with G1_XIST 1 Preset control enabled

G1_XIST 1 Preset control = Disabled
With the parameter G1_XIST 1 disabled, and if the position value increases or decreases outside the maximum value 
or below 0, the device will output the maximum position value within the scaled total range for the position value 
G1_XIST 2. The position value G1_XIST 1 is not limited to the scaled total range. For the position value 
G1_XIST 1, the device will continue to output a scaled position value within the encoder’s total measuring 
range (up to 33,554,432 positions for a 25-bit encoder).
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Example of non-cyclic scaling with G1_XIST 1 Preset control disabled:
Measuring units per revolution  = 100
Total measuring range  = 5,000 (number of revolutions 50)

Non-cyclic scaling with G1_XIST 1 Preset control disabled 

Handling 64-bit data
Siemens hardware confi guration tool does not support 64-bit data type, so when writing larger numbers than 
32 bit into the confi guration tool, this needs to be done according to below:

Example:
Total measuring range in measuring units = 236  

 MSB LSB
236= 68719476736 = 0x 00 00 00 10  00 00 00 00

Take the 4 least signifi cant bytes above and convert to decimal:
0x00 00 00 00 = 0  = Total measuring range LSB

Then take the 4 most signifi cant bytes above and convert to decimal:
0x00 00 00 10 = 16 = Total measuring range MSB 

In the confi guration software enter the decimal values:
Total measuring range LSB = 0
Total measuring range MSB = 16

9.9 Maximum Master Sign-Of-Life failures

With this parameter, the number of allowed failures of the master´s sign-of-life is defi ned. 
The default value is one (1).

Parameter Meaning Value

Maximum Master Sign-
Of-Life failures

The number of permissible failures of the 
master´s sign-of-life.

1…255

Maximum Master Sign-Of-Life parameter

Note: This parameter is only supported in compatibility mode.

4 byte = 32 bit 4 byte = 32 bit
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9.10 Velocity measuring units 

This parameter defi nes the coding of the velocity measuring units used to confi gure the signals NIST_A and 
NIST_B. Standard telegram 81 has no velocity information included and the encoder does not use the velocity 
unit information in this case. Standard telegram 82.83.84 and manufacturer telegram 59000 and 59001 in-
cludes velocity output and needs a declaration of the velocity measuring unit.

Parameter Meaning Value

Velocity measuring units Defi nition of the units for the 
encoder velocity output value

See table below

Velocity measuring units for absolute encoder Value

Steps/s 0

Steps/100 ms 1

Steps/10 ms 2

Rpm 3

Coding of velocity measuring units for absolute encoder.

Velocity measuring units for CRG PROFINET gateway Value

Steps/s 0

Steps/100 ms 1

Steps/10 ms 2

Rpm/200 ms 3

Rpm/100 ms 4

Rpm/80 ms 5

Rpm/60 ms 6

Rpm/40 ms 7

Coding of velocity measuring units for CRG PROFINET gateway.

Note: In order to provide a correct velocity value the maximum permissible rotational shaft speed for single-
turn encoders used in IRT mode is limited to the values shown in the table below.

Bus cycle time Max permitted rotational shaft speed

1 ms 12000 rpm

2 ms 12000 rpm

3 ms 8000 rpm

4 ms 6000 rpm

The velocity calculations are made with a maximum of 19 bits resolution. If the resolution is higher than 219, 
the value used for velocity calculations is automatically reduced to 219.
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Example: For a 37-bit multiturn encoder with a 225 singleturn resolution and a 212 multiturn resolution, 
the maximum singleturn value for velocity calculations will be 219. For a singleturn encoder the maximum 
resolution can be up to 31 bit, but the value used for velocity calculations will in this case also be 219.

Note: In case of the steps/s unit, an average is made over 200 ms, and the value is multiplied by 5.

Note: If scaling has been set on the device, the velocity calculation is based on the scaled position value. 
Consequently the accuracy of the velocity value is dependent of the scaling set to the device.

9.11 Encoder profi le version

The encoder Profi le Version is the version of the encoder profi le document implemented in the encoder. 
This parameter is not affected by the Compatibility mode settings.

Bits Meaning

0…7 Profi le Version, least signifi cant number, (value range: 0-99), decimal coding

8…15 Profi le Version, most signifi cant number, (value range: 0-99), decimal coding

16…31 Reserved

Encoder profi le version Parameter

9.12 Operating time

The operating-time monitor stores the operating time for the device in operating hours. The operating time is saved 
every six minutes in the non-volatile memory in the device. This happens as long as the device is powered on. 

If the operating time function is not used, the operating time value is set to the maximum value (0xFFFF FFFF). 

Parameter Meaning Data type 

Operating time The accumulated power on time Unsigned 32

Operating time parameter

9.13 Offset value

The offset value is calculated in the preset function and shifts the position value with the calculated value. 
The offset value is stored in a non-volatile memory and can be read from the encoder at any time. The data 
type for the offset value is a 32-bit or 64-bit binary value with sign, whereby the offset value range is equal 
to the measuring range of the device. 

The preset function is used after the scaling function. This means that the offset value is indicated according 
to the scaled resolution of the device. 
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Parameter Meaning Data type 

Offset value The offset value for encoders with a measuring range 
of maximum 32 bits

Integer 32

Offset value 64 bit The offset value for encoders with a measuring range ex-
ceeding 32 bits

Integer 64

Offset value parameter

Note: The offset value is read only and cannot be modifi ed by a parameter write access.

9.14 Acyclic data 

Leine & Linde’s PROFINET encoders support the following acyclic data exchange functions.

9.14.1 PROFIdrive parameters 

The encoder profi le V4.1 (PNO no. 3.162) has adopted certain standard PROFIdrive parameter. 
The Leine & Linde devices support the following PROFIdrive parameters: 

PNU (Prm.no) Signifi cance Data type Read/Write

922 Telegram selection Unsigned 16 R

925 Number of Controller Sign-
Of-Life failures which may 
be tolerated

Unsigned 16 R/W

964 Device indentifi cation Array [n] Unsigned 16 R

965 Encoder Profi le Number Octet string 2 R

971 Transfer to non volatile 
memory

Unsigned 16 W

974 Base Mode Parameter Ac-
cess service identifi cation

Array [n] Unsigned 16 R

975 Encoder Object identifi ca-
tion

Array [n] Unsigned 16 R

979 Sensor format Array [n] Unsigned 32 R

980 List of supported 
parameters

AArray [n] Unsigned 16 R

PROFIdrive parameters supported
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9.14.2 Encoder and encoder gateway parameter numbers

The table below specifi es the device specifi c parameter that is supported by Leine & Linde PROFINET devices.

PNU (Prm. No) Signifi cance Data type Read/Write

61000 Name of station Octet String [240] R

61001 IP of station Unsigned32 R

61002 MAC of station Octet String [6] R

61003 Default gateway of station Unsigned 32 R

61004 Subnet Mask Of Station Unsigned 32 R

65000 Preset value Integer 32 R/W

65001 Operating status Array [n] Integer 32 R

65002 Preset value 64 bit Integer 64 R/W

65003 Operating status 64 bit Array [n] Integer 64 R

Device specifi c parameter

9.14.3 Parameter 65000 and 65002 – Preset value

The parameter 65000 and 65002 sets the value for the preset function. The parameter 65002 should be used if 
the preset value exceeds 32 bits. For more information regarding the Preset function control, see chapter 9.7.

PNU 65000

Signifi cance Preset value 

Data type Integer 32

Access Read and write

Validity range Profi le specifi c

Explanation The preset value sets the value for the preset function. The preset value can 
be stored in the non volatile memory by PROFIdrive parameter 971 and will be 
reloaded at each start up if stored.

Structure of parameter 65000 “Preset value”

PNU 65002

Signifi cance Preset value 64 bit

Data type Integer 64

Access Read and write

Validity range Profi le specifi c

Explanation The preset value sets the value for the preset function. The preset value can 
be stored in the non volatile memory by PROFIdrive parameter 971 and will be 
reloaded at each start up if stored.

Structure of parameter 65002 “Preset value 64 bit”
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9.14.4 Parameter 65001 – Operating status parameter structure

This parameter structure is a read only structure, where information on the devices operating status can 
be found. It is a complement to the PROFIdrive parameter 979 described in the Profi le for Drive Technology, 
PROFIdrive V4.1, Order nr 3.172 available from PROFIBUS and PROFINET International.

PNU 65001

Signifi cance Encoder Operating Status

Data type Array[n] Integer 32

Access Read

Validity range Profi le specifi c

Explanation The operating status displays the status of the encoder.

Subindex Meaning

0 Header

1 Operating status

2 Faults

3 Supported Faults

4 Warnings

5 Supported warnings

6 Encoder Profi le version

7 Operating time

8 Offset value

9 Measuring units per revolution

10 Total measuring range in measuring units

11 Velocity measuring unit

Structure of parameter 65001 “Operating status”
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Sub index 1: Operating status
In sub-index 1, the status of different encoder functions can be read out. The mapping of the respective 
functions is according to the table below.

Bits Defi nition

0 Code sequence

1 Class 4 functionality

2 G1_XIST1 Preset control

3 Scaling function  control

4 Alarm channel control

5 Compatibility mode

6 ... 7 Reserved for the Encoder manufacturer

8 ... 31 Reserved for future use

Parameter 65001 Sub index 1: Operating status

9.14.5 Device specifi c parameter 65003 – Operating status 64-bit structure

The parameter structure 65003 is a read only structure, where information on the 64-bit parameter 
values can be found.

PNU 65003

Signifi cance Encoder Operating Status 64 bit

Data type Array[n] Integer 64

Access Read

Validity range Profi le specifi c

Explanation The status of encoder operating parameters with 64 bit length.

Sub index Meaning

0 Header

1 Offset value 64 bit

2 Measuring units per revolution 64 bit 

3 Total measuring range in measuring units 64 bit

Structure of parameter 65003 “Operating status 64 bit”
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9.14.6 I&M functions

In addition to the PROFIdrive parameter 964, Device Identifi cation, I&M functions are supported by the encoder 
and encoder gateway. I&M functions can be accessed with record index 0xAFF0-0xAFF4. Leine & Linde devices 
support the following I&M functions. 

I&M Parameter Octets Comment

Header

Manufacturer specifi c 10  Not used

I&M Block

MANUFACTURER_ID 2 Manufacturer Id, (Leine & Linde = 394)

ORDER_ID 20 Encoder part number

SERIAL_NUMBER 16 Encoder serial number 

HARDWARE_REVISION 2 Not used

SOFTWARE_REVISION 4 Software revision

REVISION_COUNTER 2 Not used

PROFILE_ID 2 Encoder Profi le number

PROFILE_SPECIFIC_TYPE 2 Type of encoder, 

IM_VERSION 2 Version of the I&M profi le

IM_SUPPORTED 2 Value = 0 means support of I&M

Supported I&M functions
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10 Firmware upgrade

The Leine & Linde encoder supports a fi rmware upgrade function. The fi rmware upgrade function has been 
developed to offer the possibility to upgrade the encoders in the future. For more information regarding the 
fi rmware upgrade function, please contact Leine & Linde.

Before the upgrade of the encoder can start, the following tools are needed:
• A  running TFTP server 
• A  WEB browser (Internet Explorer, Firefox, Safari, Opera etc.)

The encoder itself puts no restrictions on which TFTP server to use. 
The customer can choose to use any TFTP servers.

10.1 Firmware upgrade in a PROFINET network

This is when the encoder is connected to a PROFINET network. The encoder will be provided with an IP address 
from the PROFINET IO controller (with DCP). 

The following prerequisites have to be fulfi lled in order to upgrade the encoder in a PROFINET network:
• The encoder should be attached to the network.
• The encoder must have a valid Device name and a valid IP-address (assigned with DCP).
• A TFTP server should be enabled on the LAN where the encoder is attached. See chapter 10.4 for 
 an example how to set up a TFTP server.

Once the encoder has been assigned a valid IP-address, it should be accessible on the network. 
Enter the encoder’s IP-address in the WEB browser.
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When accessing the encoder via the web browser, it will display a number of parameters. 
In the fi rmware upgrade section of the page, enter the following information:

• Server IP-address – Enter the IP-address to the TFTP server on the LAN
• Firmware fi lename – Enter the full fi le name of the new fi rmware fi le supplied by the TFTP server
• Date – Enter the current date for the upgrade. This is stored as part of the “Upgrade History“. 
 The format is yyyy-mm-dd. E.g. 2010-05-15.
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The parameters are set by clicking the “Submit Values” button. After clicking the “Submit Values” button, 
update the page in the web browser. To start the upgrade, click on the “Upgrade” button. 

A confi rmation page is displayed where the upgrade has to be confi rmed before the device starts the actual 
fi rmware upgrade process. The Continue button must be clicked in order to start the upgrade sequence.
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During upgrade, a “progress page” is displayed. Depending upon the choice of web browser, the automatically 
generated progress page will take some time to be displayed. However, the progress web page should always be 
displayed once the upgrade is fi nished. If no errors occur during upgrade, the encoder will automatically reboot 
itself and connect to the PROFINET IO-controller with the new fi rmware.
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During the upgrade, both the bus status LED and the device status LED will be fl ashing green. If an error occurs, 
both LEDS will be fl ashing red.

If the upgrade fails, check the error code displayed on the progress page. The error codes are described in 
chapter 10.3.
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10.2 Error handling

This chapter lists all the possible error codes that can occur during an upgrade error. The error code will be 
visible on the “feedback webpage”. If an error occurs, the device will not reboot itself automatically. Instead it 
will wait for user action. This is to allow the user to take the next step. E.g. the user might want to check some 
parameters before rebooting or try running the upgrade procedure again.

Failed to download fi rmware fi le from server
Error code: -2
The user should verify the IP-address and the image fi lename. If any of these is incorrect, the user should go back 
and submit the correct parameters on the main html page (index.html). If the parameters are correct, the user 
should verify that the TFTP server is running on the host computer and that the TFTP server settings are correct.

Host not responding/No contact with host computer
Error code: -3
The user should verify that the host computer is connected to the encoder. The ping command can be used for 
this purpose. If connected, go back to upgrade.html and click “Confi rm” to try and upgrade again.

Checksum Error/File image error
Error code: -4
Calculated checksum does not match the one supplied by the image fi le. The most likely cause for this problem 
is that there was an error when downloading the fi le to the encoder. Go back to upgrade.html and press “Confi rm” 
to try again.

Flash Erase/Write Error
Error code: -5
The image might be corrupt. Flash Erase or Write failed. If this error occurs, the device can still start with its 
failsafe image. It will be displayed by the “Execution State” parameter on the web page.

File Size Error
Error Code: -6
The fi rmware fi le is too big to be written to fl ash.

Insuffi cient Memory
Error Code: -7
There is not enough memory available to store the fi rmware fi le image.

Invalid Firmware File
Error Code: -8
Firmware fi le is not supported for this hardware.
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10.3 TFTP server installation

The TFTP server used in this example is a freeware TFTP server for Windows NT/XP/Vista platforms and can be 
downloaded from www.solarwinds.com.

Unzip the installation fi le and double click on the SolarWinds-TFTP-Server.exe fi le to start the installation. 
Follow the instructions on the screen to complete the installation. 

Create a folder on C:\ named TFTP_Root (if it not already exists). Copy or Move the new fi rmware fi le 
used to the C:\TFTP_Root directory.

Start the SolarWinds TFTP server and click on the File-> Confi gure tab to open up the Confi gure window.



PROFINET
USER MANUAL  www.leinelinde.com

74

In the Confi gure window:
• Make sure that the correct network interface is selected in the “Used NIC” selection menu. 
 I.e. it is the network interface which is connected to the encoder network.
• Set up the path to the TFTP root directory. I.e. the TFTP-Root directory created under C:\.
• Leave the other parameters with their default values.
• Click Start to start the TFTP server service in Windows.

Note: The server will listen to port 69. Verify that there is no fi rewall blocking the port for incoming/
outgoing requests. Temporarily disable any fi rewall if experiencing communication problems.
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11 Encoder replacement using 
 Link Layer Discovery Protocol (LLDP)

The encoder supports Link Layer Discovery Protocol (LLDP). LLDP is essentially a neighbor discovery protocol 
used by network devices for advertising their identity, capabilities and interconnections.

In a PROFINET network, all IO devices are recognized by their device name. Sometimes an IO device needs to be 
replaced in an automation system, and this is when LLDP is useful. Using LLDP, the neighbor relations between 
the individual IO device and the IO controller are analyzed and stored on the IO controller. If an IO device has 
been replaced, the IO controller will recognize this and will redefi ne the device name.

Follow the instruction below to exchange an IO device using LLDP:

Select the properties of the PN-IO controllers interface module and enable Support device replacement 
without exchangeable medium.
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Confi gure the topology of the system for all connected ports.

 

In the properties window, select the corresponding partner port. 
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Then select Edit-> PROFINET IO-> Topology to open the “topology editor”.
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Verify that the offl ine topology matches the online topology.

Once the above has been verifi ed, it is possible to replace any IO device if the ports are reconnected 
in the same way and the new device is set to factory reset.

To manually perform a factory reset for the encoder, follow the steps below:

Select PLC-> Ethernet-> Edit Ethernet Node.
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Enter the encoder´s MAC-adress and then click on the Reset button. 
The MAC-adress of the encoder is written on the encoder label.

Click “yes” in the confi rmation window to reset the encoder to its factory settings.
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12 Encoder state Machine
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12.1 Normal Operation state

12.1.1 Profi le Version 4.x

If using encoders complying with encoder profi le v4.1, then bit 10 “Control by PLC” in Control word 2 needs to 
be set before the data in Control word is valid. If not set, Control word is not used by the encoder fi rmware.

12.1.2 Profi le Version 3.x

If using encoders complying with encoder profi le 3.x, the data in Control word is always valid and bit 9
“Control requested” in Status word 2 is always cleared.

12.1.3 Profi le Version 3.x and 4.x

When using telegram 81-83 and Control word bit 13 “Request absolute value cyclically” is set, then Status word 
bit 13 “Transmit absolute value cyclically” is set. Status word bit 13 is cleared (bit 13=0) when Control word bit 
13 is cleared. Status word bit 13 is always cleared when using telegram 84, due to the fact that no absolute 
value is sent in G1_XIST2.

12.2 Parking state

This state can be reached from any other state. The position value in G1_XIST1, G1_XIST2 and G1_XIST3 
are set to zero. Errors are cleared and alarms are disabled in parking mode. 

12.3 Set/shift home position (Preset)

The Set/shift home position is initiated when Control word bit 12 “Request set/shift of home position” is set. 
In this case the Status word bit 12 “Set/shift of home position executed” is set to 1. In order to initiate a set/shift 
home position, Class 4 functionality must be enabled (see chapter 9.2), otherwise there will be an error 
in G1_XIST2.

12.3.1 Preset depending on different telegrams

When using standard telegram 81-83, the acyclic encoder parameter 65000 “Preset value 32” bit should be used 
to set a preset value (<=32 bit) for the encoder. If the acyclic encoder parameter 65002 “Preset value 64 bit” is 
used in this case, an error message will be returned. With telegram 81-83, the operating status must be read 
by encoder parameter 65001 “Operating status 32 bit”.

With telegram 84, the acyclic encoder parameter 65002 “Preset value 64 bit” should be used to set a preset value 
(<=64 bit) for the encoder. If the acyclic encoder parameter 65000 “Preset value 32 bit” is used in this case, an er-
ror message will be returned. With telegram 84, the operating status must be read by encoder parameter 65003 
“Operating status 64 bit”.

12.3.2 Absolute preset with negative value

Preset data sent with acyclic encoder parameter 65000 or 65002 are signed values. The relative preset mode 
uses signed preset values, but with the absolute preset mode no preset will be made if a negative preset value 
(set with encoder parameter 65000 or 65002) is used while trying to initiate an absolute preset.
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12.4 Error state

This state is reached when an error has occurred. The encoder can enter this state from both the normal 
operation state and the set/shift home position state. If an error occurs, the Status word bit 15 “Sensor error” 
is set, and the error code is displayed in G1_XIST2 instead of the position value. 

12.5 Error acknowledgement

This state is reached when an error has occurred, and Control word bit 15 “Acknowledging a sensor error” has 
been set. The Status word bit 11 “Requirement of error acknowledgment detected” and Status word bit 15 
“Sensor error” are set to 1.

12.6 Start Up

This state is only reached when Control word bit 14 “Activate parking sensor” are cleared (=0). Once the Control 
word bit 14 is cleared, it takes about 500ms before the Status word bit 14 “Parking sensor active” are set to zero (=0).
The reason for the delay is that before the encoder goes to normal operation mode, an initializing of the 
encoder is made.
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13 Frequently asked questions, FAQ

1. Problem: Preset, parking mode and error reset is not possible.
 Solution: The Control By PLC bit in Control Word 2 has to be set to 1 (Profi le V4.1).

2. Problem: The preset value is lost if the power supply is switched off.
 Solution: Parameter 971 has to be set to 1 in order to save the preset value into non volatile memory.
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14 Revision history

Revision Date Changes

Rev. 01 2012-06-28 First release

Rev. 02 2013-07-04 Added information about the 
CRG PROFINET Gateway

Rev. 03 2014-04-25 Added manufacturer specifi c 
telegram 59000 and 59001
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+46-(0)152-265 00 www.leinelinde.com

The best encoders are those you never have to think 
about. Those that simply do their job – year after year. 
Leine & Linde develops and manufactures custom-
ised encoder solutions for demanding environments, 
advanced measuring systems for accurate feedback 
of speed and position.
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